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1. Introduction 

Thank you for purchasing Wordman’s Acroliter. 

Wordman’s Acroliter, an add-in for Microsoft Word, combines two of 
Wordman’s most popular add-ins, Wordman’s Acrogen and Wordman’s 
Hiliter, into one tool. 

Wordman’s Acrogen provides a tool for creating abbreviation lists for pro-
posals rapidly and accurately. You can use Wordman’s Acrogen on a sin-
gle, open document (the Active Document) or on a folder containing mul-
tiple Word documents. It is rapid, accurate and produces a new docu-
ment with a table of abbreviations that lists the page number of the first 
occurrence of each abbreviation, or the page numbers of each occur-
rence, and, optionally, a total count of the occurrences of each abbrevia-
tion. Wordman’s Acrogen defines an abbreviation as: 

• A word with more than one uppercase letter, e.g., DoD, and WBS. 

• A word with at least one uppercase letter and one number, e.g., 3D 
and C4ISR. 

Wordman’s Hiliter provides a tool for easily highlighting multiple words 
and phrases (“keywords”) in a proposal document, based on a custom 
list that you can share throughout your proposal team. This add-in can 
help to ensure compliance with official proposal terms, and to avoid 
accidental previous client names from being included when reusing con-
tent. 

You can create and manage multiple keyword files and share them with 
other members of your proposal team. Each keyword can have different 
search options, e.g., only matching the whole word rather than the key-
word embedded in other words, and a different highlight color. 
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2. Installation 

Wordman’s Acroliter is supplied in a ZIP file, Wordman_Acroliter.zip. Save 
this file to your PC, open the ZIP file, and extract Wordman Acroliter.dotm 
to the special folder that Microsoft Word uses to store add-ins. 

To do this, first open Windows Explorer by pressing the Windows button, 
, and E together. In the address box, type %appdata% and then press 

Enter: 

 

Windows Explorer displays the contents of your personal AppData/ 
Roaming folder. Open the Microsoft folder, and in that folder, open the 
Word folder. In the Word folder, open the STARTUP folder. Save the 
Wordman Acroliter.dotm into the STARTUP folder. 

You will see Windows has expanded %appdata% to the full path, e.g. 

C:\users\[username]\appdata\roaming\microsoft\word\STARTUP 

where [username] is your username on your PC. 
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3. Licensing 

Wordman’s Acroliter is a licensed product. After you have installed and 
first run Wordman’s Acrogen, a thirty-day evaluation period starts, allow-
ing full functionality. After the thirty-day evaluation period expires, you 
need to purchase a full license to continue using Wordman’s Acroliter. To 
enter a full license key, click  About in the Acrogen and Hiliter group 
on the Wordman ribbon tab: 

 

On the About Wordman’s Acroliter dialog, click Enter Key. Wordman’s 
Acroliter displays the Wordman’s Acroliter License dialog: 

 

Enter the Username and Key you received by email from Wordman 
Speaks when you purchased your Wordman’s Acroliter license. 
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4. Creating an Abbreviation List 

To create an abbreviation list, click  Create List in the Abbreviations 
group on the Wordman ribbon tab: 

 

4.1. List Options 

You can choose to Only list page number of first occurrence of each 
abbreviation, or List page numbers of each occurrence of each abbrevia-
tion. This allows you to ensure that each abbreviation is spelled out in full 
on the first occurrence, and not on remaining occurrences. 

When you select List total occurrences of each abbreviation, Wordman’s 
Acrogen adds an extra column to the output table with the total occur-
rences of each abbreviation. You can then decide whether you need to 
provide the abbreviated form if the abbreviation is used only once. 
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4.2. Documents 

If your proposal is in one document, then by default you only need to open 
the document and run Wordman’s Acrogen. 

If your proposal comprises multiple documents, but you want one 
inclusive abbreviation list, select Create list for all documents in a folder. 

Wordman’s Acrogen enables the  Select folder button. Click this and 
browse to the folder containing your documents. 

Note: The Select Document Folder dialog only shows folders, not the files 
in those folders.) 

Wordman’s Acrogen displays the selected folder on the Create 
Abbreviation List dialog: 

 

With the multiple document option selected, Wordman’s Acrogen auto-
matically selects the List all page numbers of occurrences of each ab-
breviation option and adds the filename to the listed page numbers. 

4.3. Highlight 

To make it easier to find abbreviations in your documents, check High-

light abbreviations in doc(s). Wordman’s Acrogen enables the  High-
light color button. Click this button to choose the highlight color: 

 

If you select the Create list of all documents a folder option, and check 
Highlight abbreviations in doc(s), Wordman’s Acrogen creates a sub-
folder named Highlights with the date and time and saves a copy of each 
document processed with the abbreviations highlighted. 
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Note: After you have run Wordman’s Acrogen with highlights, you can 
remove all highlights (not just those created by Wordman’s Acrogen) 

from the active document. To do this, click  Clear All. 

4.4. Running Wordman’s Acrogen 

To run Wordman’s Acrogen, click  Go! Wordman’s Acrogen displays the 
total number of words to scan, the number scanned, the elapsed time, 
the scanning speed (words per second), and the total and unique number 
of abbreviations found. The upper progress bar and percent complete 
display gives you a visual indication of how far Wordman’s Acrogen has 
scanned through the document. 

If the Create list of all documents in a folder option is selected, the file-
name of the document being scanned is displayed, and the lower pro-
gress bar and percent complete display gives you a visual indication of 
how far Wordman’s Acrogen has scanned through the documents found 
in the selected folder. 

4.5. Output Document 

This is a typical output from Wordman’s Acrogen with multiple docu-
ments: 

 

The table columns are as follows: 

• Abbreviation: The abbreviations found by Wordman’s Acrogen in the 
Active Document or selected documents. See the three notes at the 
end of this section for more details. 

• Meaning: You can enter the full version of the abbreviation in this 
column. 

• 1st Page/Pages: Lists the page number of the first occurrence of 
each abbreviation, or the page number of each occurrence of each 
abbreviation, including the document name if the list was created 
for all the documents in a folder. 
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Wordman’s Acrogen also finds abbreviations in other document areas 
and returns to following information: 

– Header: hdr 

– Footer:  ftr 

– Footnote page number, followed by fn 

– Endnote section number, followed by en 

– Text Box page number, followed by tb 

– Comment page number, followed by c 

• Count: only displayed if List total occurrences of abbreviation is se-
lected. If you only have one occurrence of an abbreviation, you can 
decide to simply spell it out in full and not include the abbreviation, 
saving some space. 

Note 1: As a proposal development best practice, when an abbreviation 
occurs multiple times, make sure you spell out the meaning in full at the 
first occurrence in each document and not thereafter. 

Note 2: Since Wordman’s Acrogen is looking for words with two or more 
uppercase letters, it finds words that have been capitalized when typed, 
e.g., in headings. You can minimize this by going to those words, pressing 
Shift+F3 to toggle between uppercase, lowercase, and finally title case. 
If a particular heading should be in uppercase, ensure All caps is checked 
in the heading style’s font settings. 

Note 3: The definition of a word, internal to Microsoft Word, is characters 
separated by punctuation. Therefore, in this definition, AT&T is three 
words—AT, &, and T—since Word does not recognize an ampersand as a 
character. To get around this problem, and identify AT&T as an abbrevia-
tion, Wordman’s Acrogen converts all ampersands to the capital thorn 
character, Þ. (Icelandic is the only language that uses the thorn character, 
so if you are preparing a proposal in Icelandic, please contact Wordman 
Speaks for a custom version of Wordman’s Acrogen.) After generating 
the abbreviation list, Wordman’s Acrogen converts all thorn characters 
back to ampersands. 
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5. Formatting an Abbreviation List 

Use the abbreviation list created above to: 

• Ensure all abbreviations are valid and correctly used 

• Establish the correct meaning for each abbreviation 

• Ensure the first occurrence of the abbreviation is written out in full 

• Ensure remaining occurrences are not written out in full 

After you have completed these activities, you can use Wordman’s Acro-
gen to format your abbreviation list, ready for submission with your pro-

posal. Click  Format List in the Abbreviations group on the Wordman 
ribbon tab. 

Wordman’s Acrogen displays the Autoformat Abbreviation List dialog: 

 

By default, Wordman’s Acrogen displays Active Document as the se-
lected document, providing the Active Document contains a table with at 
least two columns. 
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By default, Wordman’s Acrogen will format the active document, but you 
can select another document by selecting Other document…, clicking 

 Select document, and then browsing to the document. Wordman’s 
Acrogen displays the selected document: 

 

Next, select the proposal (document) template you want to use to format 
your abbreviation list. (Your proposal template contains the page setup, 
headers, footers, and formatting styles for your proposal.) Click 

 Select under Proposal template. Wordman’s Acrogen displays your 
selected template: 

 

Next, under Format, select either a one-column or a two-column abbrevi-
ation list format. If you select a two-column list format, you can set the 
gap between the two columns: 
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Finally, click  Format to create your formatted abbreviation list. Word-
man’s Acrogen creates the formatted list, for example: 

 

Wordman’s Acrogen creates two new styles in the abbreviation list docu-
ment: 

• AA Header: used for the heading characters A, B, C, etc. 

• AA List: used for the list entries 

You can modify these styles in the finished formatted list to suit your pro-
posal template. 
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6. Using Wordman’s Hiliter 

6.1. Displaying the Hiliter Dialog 

To display the main Wordman’s Hiliter dialog, click  Hiliter in the Hiliter 
group on the Wordman ribbon tab: 

 

When you first run Wordman’s Hiliter, it will start with a new keyword file, 
i.e., there will be no keyword entries. Once you have created and saved at 
least one keyword file, it will load the last used keyword file (if available) 
when it starts. 

Keyword file displays the filename of the current keyword file, next to 

 File and  Save/Save As buttons. 

Keywords and Phrases displays keywords, selected colors, and match 
options. 

Edit selected Keyword or Phrase: A group of buttons—  Add,  Edit, 

and  Delete —allow you to edit keywords. 

Run-time Options: Select to save the date and time that you ran 
Wordman’s Hiliter on the active document, the filename of the 
keyword file, and the date that the keyword file was last saved. See 
6.5, Run-time Options. 

 Clear All clears all highlighted text in the active document 

 Check… displays whether Wordman’s Hiliter has been run on the 
active document, and if so, when and using which keyword file. See 
6.5, Run-time Options. (Note: this is dependent on Save run date 
and file name in Document Properties having been previously 
checked.) 
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 Go… highlights text in the active document using the keyword 
settings. See 6.6, Highlighting Keywords in Your Document. 

6.2. Adding or Editing a Keyword or Phrase 

To add your first keyword, or to edit an existing keyword, click  Add, or 

select the keyword and then click  Edit, to display the Add/Edit Key-
word dialog: 

 

Type the keyword in the text box under Keyword or phrase, e.g., if you are 
reusing proposal content, you could type the name of a previous client. 
There are nine Match options that you can use to modify the keyword 
search: 

Match case: When checked, highlights only words or phrases that have 
the same case as the keyword. 

Whole words only: When checked, highlights words such as “word” but 
not “Wordman”. Non-alphabetic characters in the keyword box 
disables Whole words only. 

Match prefix: When checked, highlights words beginning with the 
keyword. 

Match suffix: When checked, highlights words ending with the keyword. 

Use wildcards: When checked, only highlights the exact keyword: see 
6.2.3, Using Wildcards. Checking Use wildcards disables Match 
case, Whole words only, Match prefix, and Match suffix, and 
unchecks Sounds like, and All word forms (if checked). 
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Sounds like: When checked, highlights homonyms, or words that sound 
the same as the search word, e.g. “their” and “there,” “deer” and 
“dear,” or “hear” and “here.” Checking Sounds Like disables Match 
case, Whole words only, Match prefix, and Match suffix, and 
unchecks All word forms (if checked). 

All word forms: When checked, highlights all variations of a word, e.g., if 
the keyword is “walk,” also highlights “walking” and “walked.” 
Checking All word forms disables Match case, Whole words only, 
Match prefix, and Match suffix, and unchecks Use wildcards and 
Sounds like (if checked). 

Ignore punctuation: When checked, highlights text that is similar to the 
keyword, but contains punctuation within it. For example, if the 
keyword is “recreated,” Wordman’s Hiliter also highlights “re-
created.” 

Ignore white-space: When checked, highlights text that is similar to the 
keyword, but may contain spaces. For example, if the keyword is 
“Wordman,” Wordman’s Hiliter highlights “Word Man.” 

The table below summarizes the combinations of Match options: 
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Case  ✓ ✓ ✓    ✓ ✓ 

Whole word ✓  ✓ ✓    ✓ ✓ 

Ignore punctuation ✓ ✓  ✓ ✓ ✓ ✓ ✓ ✓ 

Ignore white-space ✓ ✓ ✓  ✓ ✓ ✓ ✓ ✓ 

All word forms   ✓ ✓      

Use wildcards   ✓ ✓      

Sounds like   ✓ ✓      

Match prefix ✓ ✓ ✓ ✓     ✓ 

Match suffix ✓ ✓ ✓ ✓    ✓  
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6.2.1. Inserting Special Characters 

Special characters include em dashes and non-breaking hyphens, and 
simple wildcards such as Any Digit and Any Character. To insert a spe-
cial character in your keyword, click Insert Special Characters…, and then 
select the special character from the dropdown list: 

 

Wordman’s Hiliter inserts the following codes into your keyword: 

Special Character Code  Special Character Code 

Tab Character ^t  Em Dash ^+ 

Any Single Character ^?  En Dash ^= 

Any Digit ^#  Non-breaking Hyphen ^~ 

Any Letter ^$  Non-breaking Space ^s 
  

 Optional Hyphen ^- 

Inserting a special character disables the Whole words only option. 

6.2.2. Selecting a Highlight Color 

Each keyword can have its own highlight color from the set of sixteen 

colors allowed by Word. To select a color, click  Highlight Color: 
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6.2.3. Using Wildcards 

(The following guidance for using wildcards is from Microsoft Word help.) 

To search for a character that is defined as a wildcard, type a backslash 
(\) before the character, e.g., type \? to find a question mark. You can use 
parentheses to group wildcard characters and text, and to indicate the 
order of evaluation, e.g., type <(pre)*(ed)> to find “presorted” and “pre-
vented.” 

To find Type Example 

Any single character ? s?t finds “sat” and “set” 

Any string of characters * s*d finds “sad” and “started” 

The beginning of a word < <(inter) finds “interesting” and 
“intercept,” but not “splintered” 

The end of a word  > (in)> finds “in” and “within,” but not 
“interesting” 

One of the specified characters [ ] w[io]n finds “win” and “won” 

Any single character in this range  [-] [r-t]ight finds “right” and “sight”. 
Ranges must be in ascending order 

Any single character except the 
characters in the range inside the 
brackets 

[!x-z] t[!a-m]ck finds “tock” and “tuck,” 
but not “tack” or “tick” 

Exactly n occurrences of the pre-
vious character or expression 

{n} fe{2}d finds “feed” but not “fed” 

At least n occurrences of the pre-
vious character or expression 

{n,} fe{1,}d finds “fed” and “feed” 

From n to m occurrences of the 
previous character or expression 

{n,m} 10{1,3} finds “10”, “100” and “1000” 

One or more occurrences of the 
previous character or expression 

@ lo@t finds “lot” and “loot” 
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6.3. Saving Your Keyword File 

Click  OK to close the Add/Edit Keyword dialog. Your keyword(s), 
options, and selected color are displayed in the table on the Wordman’s 
Hiliter dialog: 

 

To save your keyword file, click  Save As at the top of the dialog. If you 
close the Wordman’s Hiliter dialog by clicking  at the top right of the 
dialog, Wordman’s Hiliter notifies you if your keywords have not been 
saved: 

 

Wordman’s Hiliter will confirm that your file has been saved successfully: 
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6.4. Opening a Keyword File 

To open another keyword file, click  File at the top of the Wordman’s 
Hiliter dialog. Wordman’s Hiliter displays the Open Keyword File dialog: 

 

There are three methods: 

Open a file from the list of Recent Keyword Files: click on the file you 

want to open, and then click  OK, or simply double-click on the 

file. 

Open a file that is not on the list of Recent Keyword Files: click  Open 
and select the file from the Windows Open File dialog. 

Create a new keyword file: click  New and Wordman’s Hiliter will clear 
the keyword list and the filename. 
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6.5. Run-time Options 

If you check Save run date/filename in Document Properties, Wordman’s 
Hiliter adds three entries to the document’s Custom Properties: 

LastHiDate: the date and time that Wordman’s Hiliter was last run on 
this document 

HiFileName: the filename of the keyword file that was used 

HiFileDate: the date and time that the keyword file used was last 
modified 

To check whether Wordman’s Hiliter has been previously run on the active 

document, click  Check… on the Wordman’s Hiliter dialog. If Word-

man’s Hiliter has not been previously run on the active document, or Save 
run date/filename in Document Proprieties was not checked prior to the 
previous run, or the document properties have been deleted, Wordman’s 
Hiliter displays the following: 

 

Otherwise, Wordman’s Hiliter displays the details about the last run: 

 

Note: To view the Custom Document Properties in the Document Prop-
erties dialog, go to File > Info, and then click the arrow next to Properties. 
Click Advanced Properties: 
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Select the Custom tab on the Document Properties dialog: 

 

To remove these custom document properties prior to delivering or dis-
tributing the document, do either of the following: 

Go to the Document Properties dialog (as described above), select, and 
then delete each of the properties, or 

click File > Info, and then, under Inspect Document, click Check for 
Issues > Inspect Document. 

6.6. Highlighting Keywords in Your Document 

Once you have finished editing your keyword list, click  Go… on the 
main dialog. 

6.7. Clearing All Highlights 

To clear all highlighting in your document, click  Clear All on the 

Wordman’s Hiliter dialog, or click  Clear in the Hiliter group on the 
Wordman ribbon tab. 
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7. Technical Details 

7.1. Keyword (*.wmh) Files 

Keyword files have the file extension .wmh, for Wordman’s Hiliter, and are 
Extensible Markup Language (XML) files. The structure of a keyword file 
is as follows: 

<?xml version="1.0" encoding="UTF-8" ?> 
<!--(C) 2011 Dick Eassom. All Rights Reserved--> 
<Keywords> 
 <Keyword> 
  <Text>[Keyword]</Text> 
  <Options>[Options]</Options> 
  <Color>[Color Name]</Color> 
 </Keyword> 
 . 
 . 
 . 
</Keywords> 

There is a Keyword group for each word or phrase in the list. Each 
Keyword group comprises: 

<Text> the word or phrase text 

<Options> the search options, in text form, separated by commas, e.g., 
<Options>Case, Whole words</Options> 

<Color> the name of the highlight color, e.g., 
<Color>Turquoise</Color> 

Any characters in the <Text> field that have a special meaning in XML are 
replaced with their Hypertext Markup Language (HTML) codes: 

Character HTML Code 

> &gt; 

< &lt; 

& &amp; 

“ or ” &quot; 
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7.2. Where does Wordman’s Hiliter look for Keywords? 

Wordman’s Hiliter searches all possible areas of the Word document be-
ing examined. These areas are known as “story ranges.” There are poten-
tially 17 different story types in each Word document, and some story 
types can comprise multiple story ranges. For example, the Primary 
Header Story can contain multiple headers. 

Furthermore, ranges in some story types can contain other story ranges, 
e.g. a Header Story can contain a Text Frame Story, i.e. text in a text box. 
Wordman’s Hiliter checks the text in these stories as well. 

8. Disclaimer 

Every effort has been made to make this document as complete and as 
accurate as possible, but no warranty of fitness is implied. The infor-
mation provided is on an “as is” basis. The author shall have neither lia-
bility nor responsibility to any person or entity with respect to any loss or 
damages arising from the information contained in this document. 

9. End User License Agreement 

All copyrights to Wordman’s Acroliter (“the software”) are exclusively 
owned by the author, Wordman Speaks. 

The software is only provided free for evaluation purposes. After the 
thirty-day evaluation period has expired, the user must purchase a license 
to continue using the software. A user is granted a non-exclusive right to 
use the software on one computer for any legal purpose. The software may 
not be rented or leased and may not be distributed without written permis-
sion of the copyright owner. 

The software is distributed “as is.” No warranty of any kind is expressed 
or implied. You use at your own risk. The author will not be liable for data 
loss, damages, loss of profits, or any other kind of loss while using or 
misusing this software. 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decom-
pile, disassemble or otherwise reverse engineer the software, or any sub-
set of the software, except as provided for in this agreement. 

All rights not expressly granted here are reserved by Wordman Speaks. 
Installing and using the software signifies acceptance of these terms and 
conditions of the license. If you do not agree with the terms of this 
license, you must remove the software from your computer and cease to 
use the product. 


